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Welcome to the OVERS User Guide

he Oregon Vital Events Registration System (OVERS) is a secure, web-based vital

records management system that uses standard web navigation techniques and
functionality. The application includes tools used to search and verify the quality and
completeness of the data entered.

OVERS allows both State staff and state partners such as Medical Examiners,
Physicians, Funeral Directors, Hospitalists, and Hospital Birth Clerks to initiate, update,
and process birth, fetal death, and death records.

The Facility-level Administrator role was created to expedite the process of fingerprint
enrollment and password resets for medical certifiers (physicians and/or hospitalists),
birth attendants, and birth clerks working in larger hospital facilities. Optionally, the
facility administrator may also enter the death certificate information on behalf of the
medical certifier, but shall not sign birth or death certificates.

Facility-level Administrators are designated by the facility with which they are associated
and agree to perform the following tasks.

e Enroll fingerprints for new users and affirm their identity by reviewing their
picture identification.

e Reset passwords for users as necessary.

e Notify the OVERS project office when staff leave your facility or when their
contact information changes.

e (optional) Enter the death certificate information on behalf of the medical
certifier

This step-by-step guide explains the techniques for assisting physicians with common
issues such as resetting passwords and enrolling fingerprints.

To learn more about entering death certificate information into OVERS, see the online,
self-paced training, Doctor’s Guide to Electronic Death Certificates at
http://public.health.oregon.gov/BirthDeathCertificates/ReqisterVitalRecords/overs/Pages
[SPTrain.aspx .

Go to
http://public.health.oregon.gov/BirthDeathCertificates/ReqgisterVitalRecords/overs
[Pages/SPTrain.aspx to take the self-paced training on entering death certificates.
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Basic Navigation

In this chapter you will learn the basic navigation methodology of the
application.

System Requirements

The OVERS application is web-based and does not require the installation of any
standalone software, except for the drivers associated with the biometric device used
for signing death certificates. Most modern business computers should meet the
minimum system requirements without further modification. At minimum, access to the
application requires:
e Browser: Microsoft’s Internet Explorer (IE), 7.x or higher
e High-speed internet connection
e Operating System: Microsoft Windows 2000 with Service Pack 2 or higher; XP
with Service Pack 1 or higher; Mac X 10.4 or later running a PC emulator
e Adobe Acrobat Reader 6.0 or higher
e Fingerprint reader and associated device drivers (Only required for funeral
directors and medical certifiers. Provided free of charge by the Center for
Health Statistics.)

Navigation Menu

The OVERS application includes basic navigation controls commonly known to internet
users. The Menu along the top of the screen appears on every page of the OVERS
application. This Menu provides easy access to the different pages and information in
the OVERS application. The Menu in the OVERS application changes dynamically
according to the permissions allowed by a user’s security profile. In other words, the
system presents a different series of screens to an individual user based on the role
they play in the system. A state office worker will be presented with a different set of
screens than a funeral director or medical certifier.

The top Menu includes levels of menu groupings that will appear when you hover over
them. Each grouping also contains sub-menus.

Avoid the Web Browser ‘Back’ Button

You may lose data entered if you navigate from one page to @ @ https://or-vitale:
another using the ‘back’ button (located on the browser’s tool '
bar). The OVERS application provides other tools for
navigating from one page to another.

Getting Started

Creating an IE Favorite

The system administrator will provide you with a web address that will take you to the
OVERS login page. Once that page is displayed in your browser, select Favorites >

| File Edit View Favorites

OVERS User Guide Facility Administrator Edition



Add To Favorites from the IE toolbar. This will launch the Favorites dialog shown
below:

Add a Favorite 3w/] The Name field will automatically be
] filled in for you, but you may change
Add a Favorite .
Lf\.. Addtljis webpage as a favorte. To access your favontes, visit the It If yOU Cho_ose' TO save the
Emas Favorite click the Add button. You
Mame:  OVERS Logen will now be able to select the
Createn: | Favortes =] [ Newfolder | OVERS webgite from your list of
stored Favorites.
Ad || Cancel |

Desktop Shortcuts

Another way to provide for quick access to the OVERS application is to create a
Desktop shortcut. First, navigate to the login page, shown below. Then, from the IE
toolbar select File > Send > Shortcut to Desktop. This will create an IE icon on your
desktop that, when selected, will automatically launch Internet Explorer and open the
OVERS login page.

Logging In

OVERS is a web-based application. All of your work in the OVERS system will be done
using Microsoft’s Internet Explorer (IE) web browser. Do not use Microsoft Edge.
Once you have accessed the system and have reached the login page you should add
the OVERS login page to your list of IE Favorites. Favorites are internet shortcuts that
allow you to navigate to a specific website quickly and easily.

Using either a Desktop shortcut or The State of Oregon - Oregon
a pre-assigned IE Favorite, access Health Authority
the main OVERS |Ogin page. OVERS Assistance Contact: 971-673-0279

Username: Password:

Version #: 15.2.0.47729

Enter your assigned username in
the User Name: field and your
password in the Password: field
and click the Login button.

Home

After successfully logging in, you will be presented with a user specific Home page.
When a user first logs into the OVERS application, actions used most often are
provided as Fast Links. All other available options are provided in the Menu along the
top of the screen. Use the menu bar along the top of the page to navigate through the
OVERS application.
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Adventist Medical Center Welcome back: facadmin e
Main Life Events Queues Reports Forms Table Maintenance Help
The State of Oregon - Oregon Health Authority
OVERS SQL 2014 TEST Fast |

41 Links
f j f j f j f jR istration Work jD th Start/Edit j
); Messages ); Current Activities ); Users ); Qigljer%homnma?"; ); N:\?\r Cas?a g ); Death Locate Case

The Messages section will not be pertinent to your work. However, the doctors you
work with will find information about cases to be completed when they log in to their
OVERS accounts.

The Current Activities section will display pending activities for your facility. For
example, it will show cases for which medical certification has been requested from a
doctor in your facility. You can access the Current Activities section from the Home
page by clicking the Fast Link for Current Activities or using the Menu by selecting
Main > Current Activities.

Change Office

Some users may have access to records in more than one office or location. For
example, a funeral director may work at several facilities or locations. In this case, the
funeral director would have one login, but would have access to multiple offices using
that login. By selecting the Change Office link from the Main Menu the funeral director
can quit working on cases in one funeral home and begin working on cases in the other.

TO Change OffICGS Adventist Medical Center
From any page in OVERS, select Main > Change Office P ctients  Quoues

Click ‘OK’ on the pop-up window.

F |
Message from webpage @
Logout

Messages Current Acti
73 e ]

| Click OK te change office.

Change Password

Messages

0K [ cance ] The State of Oregon - Oregon
L Health Authority
SQL2005 TEST - OVERS Helpdesk Number will appear here
. Username: Password:
At the login page, re-enter your facadmin 1 csnsened
password, then select the new office Selectyour Offce: |
. Adventist Medical Center 12
from the IlSt You may nOW Work Cases Legacy Emanuel Hospital & Health Center |
1 1 Legacy Good Samaritan Hospital and Medical Center 1
from the new location or office. e dns omliie
Legacy Mt. Hood Medical Center il

OVERS User Guide Facility Administrator Edition



Change Your Own Password

Typically, users are initially provided with a temporary password. This password will
allow you to login to the OVERS system. However, you will be required to change your
password before accessing the home page. Once you change the password, it will
remain in effect for ninety days. At that time, you will be required to change your
password.

However, you can also change your password at any time. From any page in OVERS,
select Main > Change Password.

Enter your old or temporary password into the Old Password text entry box. Enter your
new password into the New Password text entry box. Passwords must be between 6
and 10 characters in length and must start with a letter. It can include a combination of
characters, uppercase and lowercase letters. Passwords are case sensitive. Re-enter
the new password in the Confirm Password text entry box. Click the Save button.

Change Password
Your current passwaord is temporary. Please set new password now before logging into the system.
Old Password: | ssssssss
MNew Password: | eesssssss

Confirm Password, | sesssssas

e

Logout

Whenever you are going to be away from your desk or workstation, whether you're
going home for the day or just going to lunch, you should always log out of the OVERS
system by clicking Logout in the upper right-hand corner of OVERS.

Adventist Medical Center Welcome back: facadmin01 /

Life Events  Queues Reports Forms  Table Maintenance  Help

Resetting Passwords

rom time to time, it may be necessary to reset a password for a physician at your
facility. The Table Maintenance feature of the OVERS application is used to reset

passwords. The term “Table Maintenance” refers to the fact that all of this
system information is stored in the OVERS database tables.

Only administrative personnel have access to the Table Maintenance
features of the OVERS application. To perform Table Maintenance operations, log in,
then select Table Maintenance from the Menu.

OVERS User Guide Facility Administrator Edition



Looking up a user account Welco

The OVERS application features a simple, user- | ™" Eolesbaiaill =P
friendly interface for viewing and editing system
users. To access this feature, select Table
Maintenance > Security > Users.

Internal Testing Tools »

Organizations

Biometric Enrollment

The Users search page (shown below) will display. From this page, you can search for
a specific user, and return a listing of all users in the system associated with your
facility. Please note: as a Facility Administrator you are not permitted to create a new
user. Only the State office will create new users.

-

Search Current il Search All i New “'ser

Usemname Last Name Office

Search Current

To search for accounts for active users within the system, enter either the Username or

the user’'s Last Name and select the Search Current button:
R o

/ N———
The result of this search will be a listing of
all users whose Last Names contain “Test.”

Username Last Name Office
test

As seen in the search results table below, 2 Total Records were returned by this
search.

v v
Username Last Name Office
test
User Name 1 Name Office Name Start Date End Date
ﬂ testdoc2 Test, Another Doctor Adventist Medical Center 07152016
ﬂ testdoctor Test, Doctor Adventist Medical Center 07152016
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Notice that each of the column headers in the above search results table are the color
blue. Selecting any of these column header links will re-sort the results table according
to that particular column’s contents. The default sort order is by User Name.

Additionally, Search Current can be used with a combination of any of the three search
criteria to yield very specific results.

Search All

To return a listing of all user accounts at your facility (active and inactive) currently
setup in the system, type in the name of your facility in the office field and select Search
All:

Do
Username Last Name Office
Adventist
As shown below, this search returned 37 Total Records.
e w— e -

First1 2 3 Last Total Records: 37

Resetting a user’s password

Regardless of the search method employed, notice that the User Name displayed for
each user is actually a blue link. Selecting any of these User Name links will open the
user's User Summary page, enabling you to view or edit the user’s setup.
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Username Last Mame Office

Userld  User Name . Last Name Office

17528 ballde001 Dzgo Adventist Medical Center
2104 @ Tesl, Another Doctor Adventist Medical Center
18813 testdoctor Test, Doctor Adventist Medical Center

Selecting the User Name link above opens the summary page (shown below).
Selecting Update Login Information will open a new window enabling you to make
changes to the user’s password set up.

From the User Summary page, you should only access the “Update Login
Information” link.

User Summary

UserId: 30572 Name: Doctor Test Work Number: Medical License:

User Name: testdoctor Title: Doctor of Medicine 123 486789 Ext MD00000

Password Expiration: 10/13/2016 User Address: Cell Number: NPINumber:

Start Date: 07/15/2016 _}iiﬁ 8?2;?:3?232 Home Number- Funeral Director License:
End Date: User Mailing Address: -Bxdt

Logon Attempts: 0 1234 Test Street Fax Number: 937 654-321 Ext

Test, Oregon 87232 E-mail:
facilityadmininistrator@test.com

Preferred Contact:

epdats g2 Meodlere Sontesr nfarmenies, Lndate ] canscg

Update Login Information

Adventist Medical Center
Doctor Test is authorized to sign for the following events: Birth, Death, Fetal death

User Type Office Roles Additional Business Functions
Medical Certifier el : b External: Medical Certifier
Total records : 1 Total records : 1 Total records : 1 No data found.
R —— . .

Biometric Enroliment @

After clicking on Update Login Information, you will see the Update User page shown
below. Please note that you should not fill out every box on the page and do not click
on any links along the left-hand menu. More details are provided below:
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Select to Update a User 1. User Account Step 1 0f 9

1. User Account

3Ngontact Information

Password: » Fassword and Confirm Password
lo not need to be re-entered unless
Confirm Password: |» hey need to be modified.

Temporary Passwordf []

Login(s) Attempted: | 0 Reset

Password Expires:  |OCT-13-2016 | [T

End Date: [

— o e

Username — Do not edit.

Password and Confirm Password — You will not be able to see the current password
for the user’s account. If you need to provide the user with a temporary password, enter
that password in these fields.

Temporary Password — When a user forgets or misplaces their password then a
temporary password can be assigned. Placing a checkmark in the Temporary
Password field will flag the account and require that the user change their password
the next time they sign in.

Login(s) Attempted keeps track of the number of unsuccessful user login attempts.
Once the count reaches 3, the account will be locked. For the user to log in again, you
must reset this number by clicking Reset next to the box. This will reset the number of
Login(s) Attempted to O.

At the same time, you should also enter a temporary password for the user in the
Password and Temporary Password boxes and also select the Temporary
Password check box. As described above, tagging a password as temporary
will require the user to create a new password the next time they log into the
system.

Instruct the user that you are resetting the temporary password and they will
need to change the password the next time they log on to the account.
Passwords may be 6 to 10 characters long and, like user names, passwords are
case sensitive.

Leave the Password Expires entry box blank. OVERS will automatically assign the
expiration date.

Do not edit the Start Date. The End Date box is disabled.
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When all of the mandatory fields have been entered, select the Finish button to exit the
User Summary page and save password changes. The user should now be able to log
in with the password assigned.

Select to Update a User 1. User Account Step1o0f9
1. User Account
2. Name and Address Username: »| testdoctor
3. Contact Information
4. Licenses Password: 4| 20000000 Password and Confirm Password
= - do not need to be re-entered unless
5. Office Affiliations Confirm Password: »| esesssss they need to be modified.
6. User Types
7. User Roles Temporary Password: ]
8. Business Functions
9. Finish Login(s) Attempted:

Password Expires: C

start Date: v[JuLas2016 | [

End Date: C

e —
<o (o)

Enrolling Fingerprints

rom time to time, it may be necessary to enroll or re-enroll a physician’s
fingerprints at your facility. Fingerprints are used in the OVERS application
as a digital signature for signing birth and death certificates. Only users who
are approved to sign records may have their fingerprints enrolled.

All users enrolling their fingerprints must first provide you with picture
identification or must be known to you as a signing authority
(certifying physician).

In order for a user to digitally sign a record, a template of their fingerprint must first be
stored in the OVERS database and associated with their user account. At the time of
singing a record, the fingerprint template is compared to the signer’s fingerprint. If the
template matches the signer’s fingerprint then OVERS will accept the signature as a
valid certification of the record. For certifiers who are new to using OVERS, we
recommend a template be created for two fingers, and that each finger is enrolled
multiple times so that the user will have a good fingerprint reading. The template is
created by enrolling the user’s fingerprints in OVERS.

Steps for enrolling fingerprints

The Table Maintenance feature of the OVERS application is used for enrolling
fingerprints. The term “Table Maintenance” refers to the fact that all of this system
information is stored in the OVERS database tables.
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Only administrative personnel have access to the Table Maintenance features of the
OVERS application. To access the fingerprint enroliment feature, select Table
Maintenance > Security > Biometric Enroliment.

Adventist Medical Center

Welcome back: facadmin

Main Life Events Reports Forms

The State of Oregon - Oregon Health Authol Internal Testing Tools »
OVERS SQL 2014 TEST Organizations ,

Table Maintenance

Queues

Fast Links : Users

The Biometric Enrollment page (shown below) will display. From this page, the user
can enter their username and password to access their fingerprint enrollment screen.
After the user enters their username and password, click the Search button.

Biometric Enrollment

To proceed with the biometric enrollment process, have the user enter their username and password combination.
Username» | |

Password » | |

ED

You will be directed to the fingerprint enroliment page for the individual whose
username and password were entered. You can verify that you are in the correct user
account by checking the username that appears on the top of the screen.

P ——

Biometric Enrollment "D( 1estd:ctor)

Add a Finger | Test a Finger | Biometric Setup Files m

If a user is new to OVERSs, no fingerprints will be listed on their account. If you are
re-enrolling fingerprints for a user, a listing for each enrolled finger will appear on the
Biometric Enrollment page.

Biometric Enrellment for birthclerk
Finger Chipset Enrollment Date
Left Thumb AES3500 3/22/2013 3:42:55 PM Delete
Right Index AES3500 302212013 336:32PM Delete
Right Ring AES3500 32212013 34316 PM Delete
Add a Finger j Test a Finger Jj Biometric Setup Files m
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Add A Finger

To enter a fingerprint template for a new user, click on the Add a Finger button. You
will be directed to a new page. From the ‘Select the finger to add’ dropdown box, select
the finger you wish to enroll. Next, click on the Enroll button.

Select the finger you wish to enroll from the list.
Click enroll then follow the instructions below the sensor.

Tip: For the best results, make sure the core of the finger is visible.

Left Thumb
Left Index
Left Middle
Left Ring
Left Pinkie

[Found "UPEK Bikon Solo" Select the finger to add
Right Index
Right Middle
Right Ring

Right Pinkie

Depending on the biometric reader your facility
has (APC vs. eikon solo), the user will be
prompted to either swipe or place the
appropriate finger on the biometric devcie. To OR
create a template of a finger, the finger will
need to either be swiped along the surface of
the reader or placed on the reader
approximately 6-9 times to obtain a good Swpe the fnger Place Finger
reading.

Tips for Creating a Reliable Fingerprint Template

With an APC Reader:

e Use the ridge at the top of the biometric device as a guide for placing the finger. The
finger should lie flat on the reader and the top of the finger should rest just below the
ridge. This ensures a ‘cleaner’ image of the print and is a reminder for the user
where to place their finger when signing.

e Instruct the user to place their finger
on the biometric device using
moderate pressure and holding it in
place long enough for the device to
acquire a clear image (about 1
second).

Place so that top of
finger is right below
ridge.

¢ Lift and replace the finger about 9
times trying to place it in the same
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location each time. When the fingerprint has been registered, text will appear below
the display window prompting the user to lift and replace their finger.

With an APC Reader:
e Itis easiest to have the user hold the device in
their hand. Swipe the finger in a downward /
motion, keeping the finger flat, and apply a
moderate amount of pressure.

e The user will continue swiping their finger on the
biometric device. This process may have to be
repeated up to 9 times before the system will
have a clean image of the print to store.

Q,'é)n

8, %

When the enrollment is complete, a note will appear beneath the fingerprint image that
says, “Enrollment Finished”. You will automatically be directed back to the listing of
fingerprints.

We recommend that the user enrolls 2 fingers, and that each finger is enrolled multiple
times so that the user will have a good fingerprint reading. It does not matter which
finger is selected from the dropdown. You will be enrolling the same finger multiple
times, so the fingers you select from the dropdown don’t matter. To add another finger,
click on the Add a Finger button and repeat the process.

Test a Finger

To test the fingerprints that you’ve just
enrolled, click on the Test a Finger
button located on the page that lists the
enrolled fingerprints. On the Test a
Finger page, you will be prompted to
place a finger on the biometric reader.
Make sure to only to test fingers that
have already been enrolled.

Place the finger to identify on the sensar.

If the fingerprint is tested successfully,
the screen will display a message that
states, “Finger was identified as Left
Index”, for example. If the finger was not
successfully identified the screen will
display a message that says either,

Swipe the finger

“‘unable to identify finger”, “fingerprint
verification failed” or “bad image”.

For help troubleshooting fingerprint enroliment contact our helpdesk at 971-673-0279.
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Appendices

PUBLIC HEALTH DIVIZ KON
Cenier for Health Statistics

Appendix 1: Sample OVERS Enroliment Form

OVERS Registration Application
Send completed OVERS enmcllment form to:
FAM: 9718731201

Signature of Participant:

Name
i) Bl ]

Frofessional Tite:  OIMD oo Owo Oea ONF CICHM g Enter doctor's medical
Professional License Mumber; — license number.
Facility Name:
Work Phone:; Fau: Work Email:
Facility Address:

City. County: State; Zip Code:
Facility Mailing Address (if different):

City, County: State: Iip Code:
| attest that the above informafion iz frue and comect fo the best of my knowledge.

[iate:

Check ‘medical

Below, check the box next to your User Type/OVERS Role. {* Indicares signing authority)

DEATH REGISTRATION

Funeral Home User: D:uneral Director” D:uneral Home Staff
Medical Certifier: Medical Cenifier | IMedical Certifier Staff M:.?u:ilit},r Administra

certifier’ box for
doctors, NPs, or
PAs.

Check ‘facility
administrator’ for

Medical Examiner: Dl'u'le-dical Examiner” DME-dical Examiner Staff

min. rt.
BIRTH REGISTRATION ad Support

OBirth Certificate Clerk® [lBirth Clerk Assistant [MHearing Screener| 10! Avsro____

nichwire® If midwite, licensed in Oregon?  [ves [Ne
:‘ﬂ'l"l?'ﬁ'rﬂ':"ﬁﬂﬂ_["’.-ﬁ'lﬁe:l'l'ﬂ D.regun ST r‘.‘ﬁ‘.'n."!’ﬁ‘l’ With the Cenfer for Heglth Sfafisiics befme |"E'.'E|'||"|.'|EI an OVERS al.‘ci:lur.r._:

Birth User Type:

Birth Clerk Work Schedue: What Days? L 01 Ow O OF Qs Ose what hours?
Manager's Name: Manager's Phone:

COUNTY STAFF

County User Type: :lC:-unrg.r Registrar DDEany Registrar

CHS USE ONLY
I
State Official: Date Account Created; dﬁemamel_ List two types of
COUNTY OR CHS USE ONLY —— identification shown.
Two Types of [dentification Shown:  Photo D) and}

Date fingerprints reqistered:

(County officials: read and zign) | have reviewed the identificafion documents of the abow Enter date
and they appear fo be genuine. To the best of my knowledge, the participant named above iz efigible . .
certify vital records in Oregon. flng_erprlnts were

i ) i reaistered.
Signature of County or State Official: Primt Mame:

County Officials - Fax this to the State office affer fingerprinf &n nf is complete.
O imfo. Complete O Setupin OVERS O CHS Database [ Added to Lists Sent emall
Mar-2014

Sign your name Print your name

Fax completed form to OVERS at 971-673-1201
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Appendix 2: Troubleshooting Browser Issues

Web page doesn’t refresh with changes

If a user is having trouble seeing changes to web pages in OVERS, their browser

settings may need to be changed.

First, direct them to click on the Tools > Internet Options link in the browser menu bar,
usually located at the top of the browser window. The ‘Internet Options’ pop-up window
will open. From the General tab, instruct the user to click on the Settings button.

(=) 2 https:

File Edit View Favorites Help
Delete browsing history...

‘or-vitalevents.hr.state.or.us/OVERS/logon.aspx

Ctrl+Shift+Del
Ctrl+Shift+P

%% B Suggested Sites v &)

InPrivate Browsing
Turn on Tracking Protection

ActiveX Filtering

e of Ori
uthorit
[Contam: 971

Fix connection problems..
Reopen last browsing session

Add site to Start menu

View downloads
Pop-up Blocker »
SmartScreen Filter »

Manage add-ons

Compatibility View settings

Subscribe to this feed...

Feed discovery

Windows Update

Performance dashboard Ctrl+Shift+U

F12 Developer Tools
OneNote Linked Notes

Skype for Business Click to Call
Send to OneNote

Internet options

-
Internet Options

B |

General ‘Se:urlty I Privacy | Content | Connections | Programs I Advanced‘

Home page
/* To create home page tabs, type each address on its own line.
i http:/public.health.oregon.gov/BirthDeathCertificat =«

https://or-vitalevents.hr.state.or.us/OVERS/logan.asg
http://www.goaogle.com -

l Use current H Use default ][ Use new tab ]

Startup
() Start with tabs from the last session I

@ Start with home page
Tabs

Change how webpages are displayed in tabs.

Browsing history

Delete temporary files, history, cookies, saved passwords, and web

form information.
Lo (o )|

| [ Accessbiity |

[ Delete browsing histary on exit

Appearance

Colors ][ Languages H Fonts

Contains tools ct

o) o ) o)

Website Data Settings lilﬂ_hJ

The “Temporary Internet

Temparary Internet Files | History | Caches and databases |

Files...” pop-up window will
open. From the options on the

Internet Explorer stores copies of webpages, images, and media
for faster viewing later.

Chedk for newer versions of stored pages:
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(Recommended: 50-250MB)
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Settings pop-up, make sure the
user has selected the, ‘Every
visit to the page’ radio button.

| Click on the OK button at the

bottom of the Settings pop-up
and at the bottom of the Internet
options pop-up to save the
change.

Then Click OK in the Internet
Options window.
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